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Introduction

 Introduction

DocuPRO Embedded Client for Ricoh - Smart Operation Panel (SOP) is an embedded solution to
connect with DocuPRO from a MFP device. This document guides you to install and configure the
DocuPRO Embedded Client SOP  
See 'Terminology: MFP on page: 
See 'Terminology: SOP on page: 
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Terminology

 Terminology

Some of the terms in this document might be unfamiliar, these are explained in more detail in this
section. In the rest of the document references have been made to this section. Go to the page
number in the reference to look up the term.

BS - Business Server
The Business Server is a piece of software that runs as a service. This service functions as the core
system for the Inepro Back Office Suite and all Inepro terminals. It communicates with the database
and terminals (including the DocuPRO embedded software running on MFP's). It stores the
transactions generated on the terminals to the database and answers queries from the terminals (like
what is this user's credit). The Inepro Business Server Config Tool allows to change almost all of the
settings in an Inepro system.

CC - Cost Centre
A Cost Centre is the location where, in bookkeeping, the costs of a product are being made. Users
can book their costs on this Cost Centre. They can either do this directly or via their department.

To let a group of users book their costs on one or more Cost Centres you can create a department or
a Cost Centre Group.
You need cost centres if you want to keep the costs of a user completely separated for instance:
lunch, copying, multiple business cases, etc..

Purse
A purse is a group of credits that can be used by the account of the user. A Purse can be Business or
Personal.

A Personal purse is the purse used for all purchases that are for personal use, like the user's lunch,
or candy from a vending machine or print or copies that are for private use. In a school students will
typically only have a Personal Purse. While teachers will have a Business Purse.

A Business Purse used for all purchases that are made as an employee, like print jobs made for the
company, lunches with customers, or copy or scan products needed for the next meeting. In a school
a teacher will typically have at least a Business Purse, but might also have a Personal purse to pay for
private items.

Soft key / Hard key
A soft key is a non-physical button shown in the software on a touchscreen. A hard key is a physical
button on the hardware device.
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Quota
A quota is an official limit on the number of items or on an amount that a user is allowed to use.

Quotas can be applied to one product or a group of products (like print products). They can be
assigned to a group of users or a single user. Quotas can either have a cost limit (like € 10.00) or an
item limit (like 250 * A4 Black & White). A combination of these is also possible, but is not
recommended for simplicity purposes. Each quota has a description that is used in the transaction
overview and reports (like "10 Euro, reset weekly").

Quotas have a period in which they are applicable.
Quotas can be scheduled with a certain interval (daily, weekly, monthly, yearly), each of these
periods has a start- and an end-moment. Within that range the quota applies (like Monday - Friday).
Outside this period, the quota is not applied until the next period starts (at the next interval (like
weekly). The quota is reset at the start of each period.

ISV - Independent Software Vendor
An independent software vendor (ISV) is an organization specializing in making and selling software,
as opposed to hardware, designed for mass or niche markets. This is in contrast to in-house
software, which is developed by the organization that will use it, or custom software, which is
designed or adapted for a single, specific third party. Relevant to Ricoh SOP (Smart Operation Panel);
an ISV only needs the Inepro Card Reader Plugin, it will write the embedded software themselves.

RED - Remote Embedded Deployer
RED (Remote Embedded Deployer). This tool is used for installation and configuration for Inepro's
DocuPRO embedded products.

Card
Cards (in Inepro terminology) are objects that have a chip (either pure on the inside, or also visible
from the outside), that can store data (for example; the users current balance) and have a unique ID.

Tag
Tags (in Inepro terminology) are child objects of an Account that have a chip (either pure on the
inside, or also visible from the outside), that cannot store data (for example; the users current
balance) and have a unique ID.



6 - DocuPRO Embedded Client for Ricoh SOP

Terminology

WIM - Web Image Monitor
Ricoh Web Image Monitor allows users to remotely monitor and change the network configuration of
Ricoh copiers, multifunctions and printers via common web browsers. Ricoh WIM can be used to
install our solution if somehow our Remote Embedded Deployer can not perform the installation.

Check printer status
Once you have entered the right IP address, you can use common browsers to see whether the
printer is ready or not.

Platform independent
Because Web Image Monitor works via web browsers rather than PC software, it is platform
independent and can be used with any operating system. As long as the target printer is networked
and has an IP address, you can check its status at any time.

User-friendly monitoring
Using Web Status Monitor is as easy as browsing the internet. Simply type in the IP address of the
printer to check, and an HTML page will appear with the status of the target peripheral.

SP Settings - Service Program Settings
The Service Program (or SP) Settings are the settings within the MFP device used to configure
behavior, enable or disable hardware, and manage other type of configuration.

SOP - Smart Operation Panel
The Smart Operation Panel is the touch screen panel on the MFP. It offers a simple, flexible way to
work. A quick UI gives one-touch access to common functions like copying and scanning or total print
job control, intuitive UIs make even the most complex layout and finishing options easy to preview
and configure. The panel allows for a visually unique and tailored look, layout and content of the
interface.

SLL -  Secure Sockets Layer
SSL or TLS (Transport Layer Security) certificates are data files that bind a cryptographic key to the
details of an organization. When SSL/TLS certificate is installed on a web server, it enables a secure
connection between the web server and the browser that connects to it. The website's URL is
prefixed with "https" instead of "http" and a padlock is shown on the address bar. If the website uses
an extended validation (EV) certificate, then the browser may also show a green address bar.

What is SSL used for?
The SSL protocol is used by millions of online business to protect their customers, ensuring their
online transactions remain confidential. A web page should use encryption when it expects users to
submit confidential data, including personal information, passwords, or credit card details. All web
browsers have the ability to interact with secured sites so long as the site's certificate is issued by a
trusted certificate authority. Inepro uses SSL to keep personal information and such secure.
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MFP - Multi Functional Printer/Product/Peripheral
An MFP (Multi-Function Product/ Printer/ Peripheral), multi-functional, all-in-one (AIO), or Multi-
Function Device (MFD), is an office machine which incorporates the functionality of multiple devices in
one, so as to have a smaller footprint in a home or small business setting (the SOHO market
segment), or to provide centralized document management/distribution/production in a large-office
setting. A typical MFP may act as a combination of some or all of the following devices: E-mail, Fax,
Photocopier, Printer, Scanner.

Smart SDK - Smart Software Development Kit
RICOH SmartSDK is the web API used for controlling Ricoh’s MFP from the applications displayed on
SmartOperation Panel installed to MFP and from the applications which run on external application
servers.
Inepro uses RICOH SmartSDK to control scan jobs, copy jobs, device management, and log
management.

SDKJ - Software Development Kit for Java
Ricoh’s Device SDK Type-J (SDK/J) is a state-of-the-art application development environment that
allows for the creation of customised embedded applications that run on Ricoh Multifunction Products.
SDK/J is based on the Java ME technology and controls most aspects of device operation, including
the control panel, and core capabilities such as printing, scanning, faxing and saving files. It is the
previous SDK, the current SDK is Smart SDK.

JRE -Java Run-time Environment
Java Runtime Environment (JRE) is a runtime-environment (software) made by Oracle that make it
possible to execute Java-programs on a computer. Java Runtime Environment consists of a Java
Virtual Machine (JVM) and everything around it necessary to execute Java programs, like an
implementation of the standard-API. Java-programs in a browser are called Java-applets..

Job
A (Print) Job is digital file that has all the information a printer needs to print the required document.
The print Job will be send from somewhere in the network to the printer, via the DocuPRO server
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 Prerequisites

Name

Services

Business Server - Version 7.18 or higher, installed on remote server

Ricoh

Ricoh MFP with SOP (Smart Operation Panel) Generation 2 or Generation 2.5

MFP must have an SSL certificate enabled!

Smart SDK on Ricoh MFP 2.40 or higher

System firmware on Ricoh MFP 1.9 or higher, with SSL enabled

Application System firmware on Ricoh MFP 1.16 or higher

SDKJ version on Ricoh MFP 12.8 or higher

Inepro installation files

Remote Embedded Deployer (RED) 7.18 or higher

DocuPRO Ricoh SOP Client.zip 7.18 or higher

Logical Ports

Application Server - Incoming (from MFP)

TCP 10028, 10035
TCP 21 and/or 990
TCP (FTP Data Channels - Configurable)

MFP - Incoming (from Application Server)

TCP 10027

MFP - Incoming (from computer executing installation)

TCP 23, 80, 8080, 443, 51443

View the port overview below to correctly configure the ports.
See 'Terminology: Business Server on page: 
See 'Terminology: MFP on page: 
See 'Terminology: SOP on page: 
See 'Terminology: Smart SDK on page: 
See 'Terminology: SSL on page: 
See 'Terminology: SDKJ on page: 
See 'Terminology: RED on page: 

Port Overview

4
7
6

7
6

7
5
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 Please make sure the prerequisites are met, before continuing
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Installation

 Install the software on the multi-functional via RED

Installation
1. Obtain the installation files:

Remote Embedded Deployer (<VERSION NUMBER>).zip: 

2. The version of the Remote Embedded Deployer (RED) must be equal to or higher than 7.18.
See 'Terminology: RED on page: 

3. Make sure Java Run-time Environment (JRE) is installed or extract the entire directory
structure and files from the *.zip file.

See 'Terminology: JRE on page: 

4. Open the Remote Embedded Deployer (Start Remote Embedded Deployer.exe).
5. Set the Business Server address.

See 'Terminology: Business Server on page: 

 

5

7

4



15

6.  Click 'Browse'.
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Installation

7. Select either a single application or a package (containing multiple apps) like
DocuPRO_RicohSOPClient<Version>.zip.

8. Click 'Open'.

9. Add one or more devices by clicking 'Add', a dialogue box will appear.
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10. Make sure the Web Image Monitor (WIM) credentials are correct.
See 'Terminology: WIM on page: 

11. Tick the IM box if you are using Generation 2.5, else if you are using Generation 2 leave it
unchecked.

12. Click Scan or add one or more IP-address to the list and click 'OK'.

13. By default all devices are selected, click 'Refresh' to get the device details.

 Please make sure that the following ports are open in the network:
Depending on the MFP's device certificate (SSL) TCP port 80 or 443 for traffic to the MFP.
TCP ports 8080 and 51443 for traffic to the MFP.

See 'Terminology: MFP on page: 
See 'Terminology: SSL on page: 

6

7
6
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Installation

14. Select the applications you want to install.
15. Select the devices you want to install the applications on.

 If you do not use an Inepro USB card reader, please uncheck the 'Configure Card Reader' option,
under the 'Settings' menu!

16. Click 'Deploy'.
17. The device will get the status 'Busy: initializing' and start to install the first app in the list.

 

18. RED will now configure the SP settings on the MFP.
See 'Terminology: RED on page: 
See 'Terminology: SP Settings on page: 
See 'Terminology: MFP on page: 

5
6
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19. Installing...

20. The selected devices will be rebooted.

21. This can take up to 10 minutes. 
22. The Business Server Settings will be configured next.

See 'Terminology: Business Server on page:  4
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Installation

23. Wait until the device status of all the selected devices has returned to 'Idle'.

24. This can take a couple of minutes depending on the number of selected applications.
25. The details column should show 'Successful' as the outcome of the action.
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26. By double-clicking the device a installation result report will be shown in the summary section.

Other RED (Remote Embedded Deployer) Functions
The RED has more functions than those described here.
More RED functions are treated in Appendix VII: Red Functions on page  
See 'Terminology: RED on page: 

78
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Configuration

 Business Server Configuration

1. Please go to the Inepro Business Server and configure your device. Make sure that at least the
Admin username and password are correctly set. This is so you are able to access the
Administrator menu on device via our applications.

See 'Terminology: Business Server on page: 

Mandatory Settings

MFPAdminUserName & MFPAdminPassword
These mandatory settings must be set to match the current device administrator username and
password of the MFP.

 Caution! The MFPAdminUsername can be case sensitive, and should in case of
Ricoh machines be set to 'admin' in stead of the default 'Admin'.

See 'Terminology: MFP on page: 

4
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GUI Related Settings

BackgroundImageURL
This is the background image used when the terminal (or in this case embedded is in use).
Enter the filename of the image here. Images should be placed in the 'C:
\ProgramData\Inepro\wwwfiles' directory. 

If you want to refer to an image on another location you can use an HTTP or HTTPS URL. Like:
'http://webserver/image.png'.
This URL should point to an image that is permanently available and reachable by the MFP's.
See 'Terminology: MFP on page: 

Inepro recommends a resolution of 1024 x 520 px, this is the native resolution. Images with different
resolution will be resized automatically and might effect the performance of the MFP. The image can
be linked both to a HTTPS address or a regular HTTP address. The file format can be any regular
format, like *.png, *.bmp, *.jpg.

BackgroundIdleImageURL
With this this option you can configure an alternative image showing on the welcome screen when
the MFP is in the idle state.
When no image is defined the image defined in the BackgroundImageURL will be used.

Enter the filename of the image here. Images should be placed in the 'C:
\ProgramData\Inepro\wwwfiles' directory. 

If you want to refer to an image on another location you can use an HTTP or HTTPS URL. Like:
'http://webserver/image.png'.
This URL should point to an image that is permanently available and reachable by the MFP's.
See 'Terminology: MFP on page: 

Inepro recommends a resolution of 1024 x 520 px, this is the native resolution. Images with different
resolution will be resized automatically and might effect the performance of the MFP. The image can
be linked both to a HTTPS address or a regular HTTP address. The file format can be any regular
format, like *.png, *.bmp, *.jpg.

7

7
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Configuration

BackgroundText
The text on the welcome screen can be set with this option, the '\n' or next line character can be
used to go to the next line.
Example:

Welcome\nPresent your card

 Note: The text colour is white and has a light shadow. This cannot be
changed.

ApplicationOrderPage1 - ApplicationOrderPage5
AppicationOrderPage#' will set the properties (the index and colour) for the application shortcuts on
the specified page.

By default these settings are blank, ie: all apps are shown in unspecified order, with the Inepro apps
shown on the first page.
By configuring these settings the order (and colour) can be defined. Applications that are not defined
will not be available for the users.

This data format is used and must be repeated for each app shortcut: [<Index>:]
<Name>[,<Colour>];

So the 'Index' and 'Colour' components are optional. 

Concept example
Example: 

1:first_appname,RED; 1:secondappname; name_without_number, #99ffcc; 3:appname with
spaces ; onlyname;

In this example the first shortcut will be at position 1 and coloured Red, the second shortcut is also
placed on position 1 moving the first shortcut to the second position, the third shortcut has no index
number and will be placed at the first free position, position 3 with colour '#99ffcc'. The fourth
shortcut is placed at position 3, moving shortcut three to the next spot, position 4, the fifth shortcut
has neither an index nor a colour component and is placed at the back.
At this moment a shortcut with a certain name can only be used once per page.
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Field example
Example: 

1:DocuPRO Print;2:DocuPRO Copy,yellow;3:DocuPRO Scan;5:Quick Copy;6:Scanner,#754292;

In this example the first shortcut 'DocuPRO Print' will be at position 1 and coloured Red, the second
shortcut  'DocuPRO Copy' is placed on position 2, coloured yellow, the third shortcut 'DocuPRO Scan'
is on position 3. The fourth position is empty. The fourth shortcut 'Quick Copy' is on position 5, the
fifth shortcut is on position 6 and has colour #754292.
At this moment a shortcut with a certain name can only be used once per page.

The name of each application is the label of the icon. It is recommended to use the English
application names.

The pre-defined colours are 'red', 'blue', 'green', 'black', 'white', 'gray', 'cyan', 'magenta', 'yellow',
'lightgray', 'darkgray'.
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Configuration

The application names (in English), that are available by default are:

Address Book 
Management

Application Site Connector Copier (Classic) Copy

Document Server DocuPRO Copy DocuPRO Print DocuPRO Scan Fax (Classic)

Fax Gallery Logout
Print/Scan (Memory

Storage Device)
Printer (Classic)

Printer
Quick Card

Authentication
Config.

Quick Copy Quick Fax Quick Scanner

Scanner (Classic) Scanner ScanPRO TimeRegIn TimeRegOut

User Guide User Info User Tools Web Browser NX Web Browser
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Functional Behavior Settings

AllowJobPropertyModification (TRUE /FALSE*)
Allows user to modify print job properties like number of copies.

AllowManualLogin (TRUE*/FALSE)
By disabling this setting only card or biometric credentials can be used to log on.

  This restriction also applies for the MFP administrator account.
MFP administrators can log in by card when their user profile within IBOS is member of
the system defined user group "Administrators"

AllowOfflineMode (TRUE /FALSE*)
If enabled, the terminal may be used when the server cannot be reached, it will not go into the
out-of-service state. The MFP will keep a cache file with the last 1000 unique users that logged
in, while the system was still online. Only these users will be able to use the system offline. Only
copy functionality will be available. Be ware that user restrictions might not be maintained is all
cases during 'Offline Mode'. Transactions made during this time will be stored locally until the
server can be reached again. When the server is online all remaining transactions are moved to
the server.

AllowTagRegistration (TRUE /FALSE*)
Users are allowed to register their own proximity credential.
As soon as an unknown card/tag is presented to the card reader, the user will be asked to enter
username and password and only then the card will be registered to the users profile. Only
applicable with USB card reader connected.
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Configuration

ApplicationMode (PRINT_COPY_SCAN* / PRINT_COPY / COPY_ONLY /
PRINTRELEASE

The running mode of an DocuPRO terminal application.
PRINT_COPY_SCAN: Users can print, copy or scan. (This is optionally limited or expanded by
the functions defined in the function group 'Global Function Limitations').
PRINT_COPY: Users can print or copy. 
COPY_ONLY: Users can only copy. 
PRINTRELEASE: Users can print only, the print(s) is/are directly released when the user logs in.
The PrintRelease feature can only be used by Direct-Release terminals.

  Please match the value in this setting with the definitions in the 'Global Function Limitations
(page:   )').

AutomaticFunctionSelection (TRUE* /FALSE)
If print jobs are available, the print job screen will be opened automatically after log on.

BypassDocuPROPrinting  (TRUE / FALSE*)
True: Allows print jobs to bypass DocuPRO and be printed directly at the MFP or printer.
False: Print jobs are not allowed to bypass DocuPRO, and will not be printed by the MFP or
printer if send directly.

  Do not set to 'True' when 'JobControlMode' (page:   ) is set to 'Confidential'.

CancelWaitingJobsWhileError (TRUE/FALSE*)
 - DEPRECATED

Automatically remove documents in error status from the (print) queue after a user logs off.
Also the session management is stricter (ideal for secure environments). Printing outside of a
user session is prohibited. Print jobs that will be send unsecured (f.e. from a Direct Release
printer) will be deleted immediately without being printed.

  This function has been replaced with the functions 'JobControlMode' (page:   ) and
'BypassDocuPRO' (page:   ). Use the 'Confidential' value in 'JobControlMode' and set
'BypassDocuPRO' to 'False' to retain the same behavior.

CopyMode (SIMPLE* /ADVANCED /SIMPLE_CLASSIC /ADVANCED_CLASSIC)
SIMPLE: User will use the DocuPRO embedded copy functions.
ADVANCED: User will use the machine's copy functions.
SIMPLE_CLASSIC: The user will use the DocuPRO embedded Copy functions and when the
extended machine's copy functions are chosen the 'Classic' Ricoh Interfaced will be used.
ADVANCED_CLASSIC: User will use the extended machine's copy functions with the 'Classic'
Ricoh Interface.

CostcenterEntryField (SHORTNAME* / CODE)
How is the Cost Center name displayed?
SHORTNAME: The short name as set in the IBOS DB.
CODE: The cost center code as set in the BOS DB.
LONGNAME: The long name as set in the IBOS DB.
CODE+LONGNAME: The cost center code followed by the long name as set in the IBOS DB.

34
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CostcenterSelectMode (*)
The way a Cost Center is selected on the terminal.
SELECT: Select the value from a list. 
SEARCH: Search the list for the corresponding item. 
SELECT_GROUPED: When 'leveled cost centres' are used, select a cost center and the cost
centers that are linked to that cost center can be selected until the bottom level has been
reached. 
DIRECT: The Cost Center code is typed in directly at the terminal (used in PosPRO).

CustomerLogoffTimeout (120*)
Timer in seconds depends how long a user stays logged on in case of no activity.
The user will be warned 5 seconds ahead of logging off by a pop-up to be able to stay logged in.

DebugLoggingEnabled (TRUE / FALSE*)
Debug logs will be generated by activation.

DefaultApplication (<empty>* / Pull print /Scan to me /Copy)
By default the users get the first page of the launcher to choose their application/action, it is
possible to enter direct the copy or scan application after log on.

DeleteConfirmationRequired (TRUE */ FALSE)
Must an end-user confirm deleting the print job?

DeviceTag (<EMPTY>*)
Our systems are mostly used to register who does what on the MFP.
When it is not required that the end-users are known in the system, and / or it is not important to
know who does what in the system, Anonymous Login can make the DocuPRO Embedded for
Ricoh interface a little bit more faster. All transactions will still be registered and can still be
required to pay for, but you can start your action with a touch on the screen.

DeviceTag holds the username that is used by the MFP to register the transactions of the
anonymous users.
The MFP logs in with the 'username' set to whatever is set in ‘DeviceTag’ (provided that a user
and an account are created as described in Appendix X) . So the empty login is overwritten by
the 'DeviceTag', and that tag has tagtype 43. If 'DeviceTag' is <EMPTY> the MFP does not log in.
The setting 'HideUsernamePassword' (page:   ) must also be set to 'True' so end-users cannot
type in a username and password (which would be redundant and confusing).

See 'Appendix X: Set up Anonymous Usage' (page:   ).

DirectManualLogin (TRUE/FALSE*)
Disable the idle screen in order to make the login process for pin code users faster

DisablePriceInfo (TRUE /FALSE*)
Don’t show print job costs in print jobs (detail) screen.

 EnablePrintJobPreviews (TRUE* /FALSE)
By default enabled, but if somehow print job previews are undesired, they can be switched off. 

FTPScanPort (EMPTY>*)
Address of the server that has the FTP service.

32
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FTPScanServer (21*)
FTP port of scan service.

HideUsernamePasswordEntry (TRUE / FALSE*)
Hide the possibility to enter a username or password.

This is needed in cases like Anonymous Usage.
See 'Appendix X: Set up Anonymous Usage' (page:   ).

JobControlMode (CONFIDENTIAL / ERROR_CONTROL / NONE*
This setting controls what happens if the user logs out of an MFP embedded.

When the current user logs out:
§ 'CONFIDENTIAL' will cancel all active and pending jobs, and the jobs that are in error state. It

also support the calculation of unprinted pages (letting users only pay for delivered items, like
pages printed). Finally the log-out is restricted until all tasks are completed. (Because all the
jobs are canceled this will not result in a perceivable delay for the user).

§ 'ERROR_CONTROL' will allow active jobs and pending jobs to be printed when the user gives
a log out command, but will delay this log out event until all the jobs have been completed. It
will also cancel the print jobs that are in error state and support the calculation of unprinted
pages (letting users only pay for delivered items, like pages printed).

§ 'NONE' No jobs will be canceled and the user is logged out directly. There is no support of the
calculation of unprinted pages, so users will pay the full price for a job that was not (yet) fully
delivered (and as a result will now be in an error state). When an error issue (like no paper in
paper tray) is resolved, the rest of the job will be printed.

Job Control Mode

Function Cancel pending
jobs

Cancel jobs in error
state

Support calculation of
unprinted pages

Restrict logout
Setting

CONFIDENTIAL * * * *

ERROR_CONTR
OL

* * *

NONE

NOTE!: When set to 'Confidential', make sure the setting 'BypassDocuPRO' (page:   ) is not be set
to 'True'. (Otherwise the security gained by setting 'JobControlMode' to 'Confidential' is
compromised).

LogOffAfterAction (TRUE/FALSE*)
Automatically logs off a user after finishing a copy, print or scan job.

LogOffAfterPrint (TRUE /FALSE*)
Automatically logs off a user after printing one or more documents.

MaskedLoginUserName (TRUE /FALSE*)
Shows stars instead of characters during username entry like password entry.

MaximumScanSize (*)
The maximum allowed size of a scan in megabytes (MB) This is so the number of bytes send
over the the mail can be restricted. The default is 0, meaning any size is allowed. 

 Mind the 'ScanResolution' setting also as it will also influence the scan size.
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MinBalance (0*)
The minimum (money or credit) balance the end-user must have to use the terminal.

MinimumPasswordLength (0*)
Security option to avoid short user passwords (length in characters).
Applies when user will be asked to enter a new password after password expiration.

PaperSizeStandard (ISO* / ANSI)
Which set of Paper Sizes should be used?
ISO: Using the ISO 216 Paper Sizes, like A4, A3, B2, etcetera. 
ANSI: Using the Loose Sizes, like Letter, Legal, Tabloid, Ledger, etcetera. On small machines
there is no auto detection, but paper size buttons are shown.

PasswordEntryMode (AUTO* /REQUIRED /DO NOT CHECK) (former
PasswordRequired)

When this setting is 'do not check', user will not be prompted for a password, neither by card or
username, even if the user has a password. This can improve ease of use for MFP’s in a secured
area like print rooms.

PrintingMode (ADVANCED* /SIMPLE/ DIRECT_IPREADER_RELEASE)
Advanced printing mode gives the user an overview of all jobs with advanced options.
Simple mode will release all print directly when the print button is pressed.
Direct IP reader mode will immediately start print all the print jobs, already before the user is
logged on. Only applicable with IP reader connected.

PurseSelection (PERSONAL_ONLY / BUDGET_ONLY / PREFER_PERSONAL /
PREFER_BUDGET / PERSONAL_AND_ASK*/ BUDGET_AND_ASK /
USE_ALL_PURSES)

PERSONAL_ONLY: Only use the personal purse, do not allow the use of the budget purse(s).
BUDGET_ONLY: Only allow the budget purse, do not allow the use of the personal purse.
PREFER_PERSONAL: If available, use the personal purse, if not use the budget purse.
PREFER_BUDGET: If available use the budget purse, if not use the personal purse.
PERSONAL_AND_ASK: Pre-select the personal purse, but leave the choice to the user.
BUDGET_AND_ASK: Pre-select the budget purse but leave the choice to the user.
USE_ALL_PURSES: Use both the personal and budget purses. First use the budget purse, if the
money runs out, continue on the personal purse within the same transaction.

ScanMode (SIMPLE* /ADVANCED / THIRD_PARTY_SOLUTION /
SIMPLE_CLASSIC / ADVANCED_CLASSIC)

SIMPE: User will use DocuPRO embedded scan functions.
ADVANCED: User will use the machine's scan functions. 
THIRD_PARTY_SOLUTION: This value is not applicable here. 
SIMPLE_CLASSIC: The user will use the DocuPRO embedded scan functions and when the
extended machine's scan functions are chosen the 'Classic' Ricoh Interfaced will be used. 
ADVANCED_CLASSIC: User will use the extended machine's scan functions with the 'Classic'
Ricoh Interface.

 As Inepro ScanPRO replaces the Simple Scan solution the setting 'Simple' must be set if
ScanPRO used.

ScanResolution (72x72dpi / 100x100dpi / 150x150dpi / 200x200dpi* /
300x300dpi / 400x400dpi / 500x500dpi / 600x600dpi)

Fixed scan resolution used for the scans made with the embedded simple scan application.
If an another resolution is selected it will automatically fallback to the nearest valid value.
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ShowButtonCaptions (TRUE/FALSE*)
Show supporting text labels on major buttons

SNMPWriteCommunityName (admin*)
By default the MFP standard username is used. In the exceptional case the login is changed on
the MFP, the login username for SNMP can be changed here accordingly.

 The 'public' user has not sufficient rights to f.e. delete print jobs. 

SupportTagHoldMode (TRUE/FALSE*)
By enabling this setting the card must be on the reader during the complete session.
Removing the card will close the user session. This prevents card loss.

TerminalLanguage (EN* / NL / DE /ES)
This is the default language of the terminal. All information (if possible) is shown in this
language.

UseCostcenters (TRUE / FALSE*)
If enabled end-users must have a cost centre selected when they make a transaction at this
terminal.

UseCustomerLanguage (TRUE*/FALSE)
If a user has its own language configured in the database, the complete MFP user interface will
(if possible) adjust to this language after the user has logged on. This will take about 2 additional
seconds during login.
If not set or if the set language is unknown or invalid the terminal will use the language set in
'TerminalLanguage' (page:   ).

 Values with * = default value.

Global function limitations
By default all functions the MFP offers are available to the users. In some cases some functions
are not desired to be offered to the users. By disabling this functionality globally the function will
not be available anymore for all users.

34
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Optional embedded modules

The following optional modules can be activated. This can require an additional
software license and/or additional applications to be installed on MFP and/or
server environment.

EnableTimeAndAttendanceClient (TRUE /FALSE*)
With this module enabled (Inepro Time And Attendance license required), users (which have the
time registration option enabled in their IBOS profile) will get additional applications to register
their logged in/out status to the system.

Go to Appendix IX: Set up Time Registration on page:   to set up Time Registration.
 

EnableScanPROClient (TRUE /FALSE*)
With this module enabled (Inepro ScanPRO license required), users can take benefit of the
advanced features of the ScanPRO software.
The ScanPRO client automatically replaces the Inepro simple scan application.

 For more information about the Business Server tool see the DocuPRO Terminal training
document.

 As ScanPROClient replaces the Inepro simple scan application, the 'ScanMode' (page:   )
setting must be set to 'SIMPLE'.

 To be able to send scans to an address book, set 'EnableScanToAddressBook' (page:   ) to
'TRUE'.

 To be able to send scans to a fax machine, set 'EnableScanToFax' (page:   ) to 'TRUE'.

 To be able to send scans to an email address, set 'EnableScanToCustomMail' (page:   ) to
'TRUE'
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DocuPRO Status Page

The DocuPRO Status Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/docupro

After logging in, using the Ricoh credentials, the DocuPRO Status Page will be shown:

This page shows you a summery of the installed DocuPRO Embedded components and their versions.

Furthermore the Business Server address can be modified and optionally you can force the
Embedded Client to update it's configuration from the Business Server directly. The Update
Configuration' button doesn't need to be used. The Embedded Client keep the configuration up-to-
date automatically. The last successful attempt is shown at 'Last Configuration Update' in the
'Business Server' Section.

If 'Offline Usage' is allowed (it's not by default), the status of offline transactions can be reviewed.
Normally offline transactions will be processed automatically after the connection with the Business
Server has been re-established. In some cases it might be necessary to delete or process the
transactions manually
See 'Terminology: Business Server on page:  4
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 Troubleshooting

Sometimes things do not work out as expected, if so please read through this section before
contacting your service organisation or dealer. Chances are you are able to solve the issue yourself.
The section is set up in a symptom - Prognosis - Resolution format, that is first the symptom is given,
then the possible causes and then the resolution for those causes.

 Symptom(s): Device has the 'Error' in the RED (Remote Embedded
Deployer) and can not be installed

 Prognosis: The device is in an error state, devices in 'error' state may not
be used.

 Scope: All Devices that have the 'error' state in the RED.

 Resolution(s): 
A - Refresh and retry.
  1) Refresh the device device, and wait a moment for the status to change.
  2) When the device does not longer have the 'Error' state, try starting the install procedure again.
B - Contact your service organisation or dealer for further solutions.
See 'Terminology: RED on page: 

 Symptom(s):  'Customer not found' error message when trying to log in as
administrator on the MFP

 Prognosis:    MFPAdminUserName  and / or     MFPAdminPassword   are
incorrect

 Scope: All devices in the same BS settingsgroup

 Resolution(s):
A - Verify the username and password in the Business Server Settings: 'MFPAdminUserName' and /

or  'MFPAdminPassword', they should match the MFP's username and password for the
administrator account. Note: MFPAdminUserName is also case-sensitive, just like the
MFPAdminPassword, in other words: 'AbC' is not the same as 'aBc' and 'Admin' is not the same
as 'admin'.

See 'Business Server Configuration: MFPAdminUsername on page: 
See 'Terminology: Business Server on page: 

 Symptom(s): Instead of starting the Ricoh launcher an application is
opened directly.

 Prognosis: The function priority setting is set to an application.

 Scope: All Devices

 Resolution: 
A - Uninstall the launcher, to enable you to get to the settings.
B - Change the function priority setting.
  1) Go to the Settings menu.
  2) Go to 'User Tools -> Screen Features -> Screen Device Settings -> Function Priority'.

5
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 Symptom(s): Card Reader does not respond at all

 Prognosis: Reader is configured as 'HID RAW' device

 Scope: All Inepro USB Card Readers

 Resolution(s): 
A - Connect the reader to a laptop or PC and reconfigure with the Card Reader tool to a non-'HID

Raw' interface type.
  1) Connect the reader to a laptop or PC.
  2) Go to the 'Programmer' tab, and click 'Switch to program mode'
  3) Select the 'default.readerconfig'.

  4) Click 'Switch to normal mode'.
  5) Disconnect the reader from the PC.
  6) (Re-)Connect the reader to the SOP (panel)  See page:  .
See 'Terminology: SOP on page: 

 Prognosis: Reader is not connected to SOP (panel)

 Scope: All Inepro USB Card Readers

 Resolution(s): 
A - (Re-)Connect the reader to the SOP (panel)  See page:  .

 Prognosis: Reader is not configured in MFP

 Scope: All Inepro USB Card Readers

 Resolution(s): 
A - Configure Card Reader in the MFP. See page:  .
B - Or run the RED again.
See 'Terminology: RED on page: 
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 Symptom(s): Error message 'Problem connecting to server'.

 Prognosis: The network cable is not connected or defect

 Scope: All Devices

 Resolution: 
A - Check if the network cable is connected.
  1) If not, connect the network cable.
B - The cable is connected but might be defect / damaged.
  1) Check if the cable might be defect.
  2) Replace the network cable to see if this resolves the issue.

 Prognosis: The network settings are incorrect

 Scope: All Devices

 Resolution: 
A - Please check the network settings.
  1) Check if the network card is in the correct range.
  2) Check if the network card has the correct subnet.
  3) Check if the network card has the correct gateway.
  4) Check if the network card is in the correct internal DNS server.
B - Check if the correct ports are open in the correct direction between the MFP and the Business

Server.
C - Ping the device from the server running the Inepro Business Server.
See 'Terminology: Business Server on page: 
See 'Terminology: MFP on page: 

4
7



43

 Prognosis: The Business Server is inactive or not listening

 Scope: All Devices

 Resolution: 
A - Check if the Business Server is active. If not; activate.
B - Check if the MFP sends its traffic to the correct IP-address. If not, adept the IP-address to the IP-

address the Business Server is listening on.
  1) Open serviceurl.pluginconfig in a text editor to change the Business Server IP.

 Prognosis: The MFP has the priority on a wrong network device type (WiFi)

 Scope: All Devices

 Resolution: 
A - If 'Wi-Fi Connection' is selected, and that connection connects to another part of the network that

cannot reach the Business Server, then the 'Problem connecting to server' message also appears.
  1) Make sure the 'Interface Settings' is set to 'Machine Network' (the LAN cable connection) or that

the Business Server can also be reaches from the WiFi network.

  Symptom(s): The issue seems unsolvable on location

 Prognosis: The issue is unsolvable on location

 Scope: Every device on location

 Resolution: 
A - Contact your service organisation or dealer for further solutions
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Card Reader config upload steps

The Card Reader Service Configuration Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/cardreader

After logging in, using the Ricoh credentials, the Card Reader Service Upload Page will be shown:

1. Select 'Card Reader Configuration'.
2. Click 'browse'.
3. Select the .readerconfig file.
4. Choose upload.

Please wait till you have seen the status message !

Updating configuration

 Note: In some cases after successful update message the status does not indicate
ready but offline, please refresh the page in the browser to accurately check the offline
status  
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Screenshot from the Inepro reader tool.

 Warning: Ricoh cannot work with the 'HID RAW' interface. Never set the
reader to the 'HID RAW' interface in combination with a Ricoh device.
If this interface type is used, the reader will be rendered useless untill it is
connected to a laptop or PC and reconfigured with the tool to a non-'HID Raw'
interface type.
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Update card reader firmware

The Card Reader Service Configuration Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/cardreader

After logging in, using the Ricoh credentials, the Card Reader Service Upload Page will be shown:

To update a new firmware, the two firmware files (digest and firmware) must be provided  
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Reader firmware upload steps

1. Choose Card reader firmware.
2. Browse and select both files, digest and firmware. (Click browse and select the files

simultaneously).
3. Choose upload.

Please wait till you have seen the status messages !

- Offline

- Erasing firmware

- Programming firmware

 Note: In some cases after successful update message the status does not indicate
ready but offline, please refresh the page in the browser to accurately check the offline
status  
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 Uninstall the Inepro solution
In some cases you might need to uninstall the Inepro solution from the MFP's. This procedure will
uninstall all Inepro applications and revert all specific MFP configuration settings back to it's default.
Follow these instructions to do so.

Uninstalling via RED (Remote Embedded Deployer)
See 'Terminology: RED on page: 

1. Select the devices to uninstall.
2. Go to the 'Devices' menu, click 'Uninstall all Inepro Apps'.

3. The devices are uninstalling as can be seen in the status and details columns of the RED (Remote
Embedded Deployer).

 

5
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4. The device will reboot afterwards, please wait for the 'Successful' status. Review the
Uninstallation Summery be double-clicking the device.
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Alternative Ricoh WIM uninstall
As an alternative to the RED uninstall method, follow the Ricoh WIM uninstall procedure. To uninstall
the Inepro solution the install steps must be carefully followed in reverse. Do not skip steps or change
the order in which the steps are taken. Mind the changed configurations, installed applications and SP
Settings configuration. And use 'Uninstall' where it says 'Install' in the manual.
See 'Terminology: SP Settings on page: 

1. First follow the installing steps in this manual in reverse, finally continue with the steps below.
2. Go to Ricoh WIM (Web Image Monitor). Select Configuration under the Device Management

menu.
See 'Terminology: WIM on page: 

6
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3. Scroll down to the left bottom of the screen. At the 'Extended Feature Settings' section, click
'Uninstall'.

4. The first page of the Uninstall menu is shown.
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5. Scroll to the last page. Select the apps you need to uninstall, like the 'Inepro Reader Plugin'
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 Enable SDK Custom Authentication

Go to the SP mode. 
For the instructions to get into the SP Mode menu refer to the multi-functional device dealer.

Binairy Settings
SP5-401-230 is a binary setting. These are edited in a specific manner. Instead of overwriting the
value, the numeric key you press on the keypad will toggle the corresponding bit.
So, the value '00000000' will change to '00100000' when the '5' is pressed on the keypad (toggling
the 5th bit.)

At 'System SP' change SP5-401-230 and toggle the 0th bit to make the value: '00000001' (press 0
untill the value of the 0th (or most-right) bit is '1' and confirm with #).
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Change 'SP5-490-001' and set to 1 (Press 1 and confirm with #)  

 Install the software on the multi-functional via WIM

This is no longer the recommended way to uninstall the software, please use the RED (Remote
Embedded Deployer). If that is not possible this method can still be used as an alternative.
See 'Terminology: RED on page: 

Log in on the web site of the Ricoh multi-functional.

5
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Choose 'Configuration'.

Choose 'Install' under the 'Extended Feature Settings', if this link is not visible not enough rights are
available, please login with the proper credentials.

Make sure to select 'Local File', no radio button is currently selected, browse and select the
installation file.
 Click install and select the app (like 'DocuPRO Auth'). Repeat this for all the apps.
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Click 'Display Extended Feature List', the file will be loaded and the Extended Feature List will be
opened.

Confirm installing the extended feature, and click .

Go back to the 'Install' step on page   and repeat the process untill all the apps are installed.62
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 If the installation is successful 0 applications should be listed in the application list in the install
section, if the installation was unsuccessful either an error message will appear or a blank screen (as
shown here below).

If the installation was a
success, the number of
applications (that can be
installed), should now be 0.

If the installation failed, either an error
message is shown or a blank page like this.

Contact Inepro Support

 Reboot the machine

Reboot the machine by using the on/off switch. Wait untill the device does not make any sound and
all the lights are off, before switching it on again.

 Note: Reboot in order to change the User Authentication Management setting "LDAP Auth" to
"Custom Auth."
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 Configure Machine authentication settings

Go to the machine's Web Image Monitor. Login as admin at the top right side with username: admin
and no password.

Device Management -> Configuration 

Click 'Administrator Authentication Management '.
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Set 'User Administrator Authentication' to 'ON' and press OK.
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Click 'User Authentication Management'.
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Set 'User Authentication Management' to 'Custom Authentication'.
Set 'Printer Job Authentication' in the 'Printer Job Authentication Settings' section to
'Entire'.
See 'Terminology: Job on page: 

Leave checkbox 1 at 'LDAP Authentication' checked in the 'LDAP Authentication Settings'.
Under 'Available Functions' uncheck all boxes.

Press 'OK'
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 Configure Tracking settings

Go to the machine Web Image Monitor
Configuration 

Click 'Print Volume Use Limitation'.
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Set 'Machine Action When Limit Is Reached' to 'Stop Job'.
See 'Terminology: Job on page: 

Set 'Enhanced Print Volume Use Limitation -> Tracking Permission' to 'On'
Set 'Enhanced Print Volume Use Limitation -> Stop Printing' to 'On'
Set 'Volume Use Counter: Scheduled/Specified Reset Settings' to the preferred period cycle.

 Note: The 'Enhanced Print Volume Use Limitation' settings will only display if the 'DocuPRO Auth'
application has been installed and the MFD has been rebooted. If these settings still don't appear on
screen, please reboot the device and try again

7
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 Configure Port Forwarding

To receive Business Server notifications and to enable the working of the IP-reader, port forwarding
is necessary.
See 'Terminology: Business Server on page: 

Open a telnet session on the machine with a telnet client, like PuTTy.

Login with (default) machine login credentials.

4
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Execute the following commands:
§ 'nat' <enter> (ports are default, check if port forwarding is On)
§ 'nat machine_port 3 10027' <enter>
§ 'nat ui_port 3 10037' <enter>
§ 'nat' <enter> (check if port 3 is changed to 10027 -> 10037)
§ 'logout' <enter>
§ 'yes' <enter>

 Select an unused port/slot (in this example we are using port/slot 3).

 Reboot the machine

Reboot the machine by using the on/off switch. Wait untill the device does not make any sound and
all the lights are off, before switching it on again.
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Configuring Card Data Encryption

 Warning: To use card data encryption Inepro Card Reader Firmware version
43.1.1188 or higher is required!
To use card data encryption you need to have your card reader configured with an encryption key.

Refer to the Card Reader Configuration Tool manual to enable encryption in the reader.

Enable Card Data Encryption
To enable card data encryption on the device create an '*.pluginconfig' file containing the encryption
key (in this example "AABBCCDD00112233" is used):

{
  "ENCRYPTION_KEY": "AABBCCDD00112233"
}

Alternatively spacing between the characters is also allowed.
{
  "ENCRYPTION_KEY": "AA BB CC DD 00 11 22 33"
}

 Warning: Make sure the 'Code Brackets', 'Key' and 'Divider' are left unchanged, and
only the 'Value' is changed.
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Disable Card Data Encryption
To disable card data encryption on the device create an '*.pluginconfig' file containing an empty
'encryption key' value:

{
  "ENCRYPTION_KEY": ""
}

 Warning: Make sure the 'Code Brackets', 'Key' and 'Divider' are left unchanged, and
only the 'Value' is changed.

Upload the encryption configuration
1. The Card Reader Service Configuration Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/cardreader

After logging in, using the Ricoh credentials, the Card Reader Service Upload Page will be shown:
2. Upload the encryption *.pluginconfig file by ticking the 'Card Reader Service Configuration' box

and click upload:

The last update information in the lower right corner should report that the upload was successful
and more importantly that 'Encryption Key Used' is now 'True'.

The card data encryption configuration has now been activated  
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RED Functions
In this section some other functions of the RED (Remote Embedded Deployer) are
described.
See 'Terminology: RED on page: 

Import Devices
Devices can be imported via *.csv (a comma (',') separated values text) files.
To understand the structure it can be helpful to first add one or two devices and then export them to
*.csv.
To import a *.csv file:
1. Go to the 'File' menu and click 'Import devices..'.

Export Devices
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'File' menu and click 'Export devices..'.

Set Business Server Address
1. Set the IP-Address or host name of the Business Server.

Set SP Settings
The SP settings of a MFP, are the internal configuration settings. These must be set correctly for the
Inepro Reader Plugin and/or Inepro Apps to work. This will be done automatically with full
deployment, however in case it is needed to separately set these settings:
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'Devices' menu, click 'Set SP Settings'.
See 'Terminology: SP Settings on page: 

Reboot Devices
To reboot a device:
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'Devices' menu, click 'Reboot devices'.
3. Do not refresh until the status and detail fields have been changed.

Uninstall all Inepro Apps
This action will uninstall all Inepro applications and revert specific MFP configuration back to default.
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'Devices' menu, click 'Uninstall all Inepro Apps'.

Logs
To troubleshoot a problem you first and foremost need to look at the log files. To provide more
accessibility to those files an internal viewer is available.
1. Click 'Open log' in the 'Help' menu.

Settings
The Settings are mostly options that can be enabled or disabled. But also the DocuPRO Business
Server address and the language of the tool are also set here.
See 'Terminology: Business Server on page: 

5
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Setting Descr iption

Force Installation 'Force Installation' w ill ev en install ov er an installation w ith the same v ersion number.

Install O nly
With 'Install O nly ' the applications are just installed or updated w ithout making changes to the MFP
configuration.

A uto Sav e Mode

A lway s Sav e - A lway s sav e dev ice  list

A sk for confirmation - A sk confirmation to sav e dev ice list

Nev er Sav e - Nev er sav e the dev ice list.

A uto Load A lway s load dev ice list when opening this application.

C onfigure C ard Reader Must card reader settings be pushed during a 'deploy '?

Business Serv er A ddress This sets the DocuPRO  Business Serv er address (O nly  needed w ith DocuPRO  Embedded installations).

Language This sets the language of the tool. It has no effect on the languages on the dev ice.

Make sure the settings are set as you need them to be, if unsure contact the dealer support
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 Install Card Reader - For G2.5 devices

The RED will automatically install the card reader and set the SP settings in the MFP, but in case this
must be done manually; use these instructions:

When the configuration thus far has been successful, you should see this welcome screen:

1. Please login to the Administrator menu, by touching the screen and entering the administrator
credentials.

 If the on-screen keyboard does not appear, a card reader is probably already
connected. Please disconnect this reader.
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2. Go to 'User Tools' -> 'Screen Features Settings':

3. 'Screen Device Settings'
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4. 'External Interface Software Settings'

5. 'Select IC Card Reader' 
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6. Select 'Proximity Card Reader':

7.  Connect the Inepro Card Reader to the SOP, preferably on the internal USB Mini-B port on the
right side of the panel, behind the cover. The USB-A port on the left side could be used as an
alternative.
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8. Wait for about 5 seconds for it to become visible.

9.  The Inepro Card reader should now be available. Click on the reader.
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10. Select 'Inepro Card Reader'
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 Install Card Reader - For G2 devices

The RED will automatically install the card reader and set the SP settings in the MFP, but in case this
must be done manually; use these instructions:

When the configuration thus far has been successful, you should see this welcome screen:

1. Please login to the Administrator menu, by touching the screen and entering the administrator
credentials.

 If the on-screen keyboard does not appear, a card reader is probably already
connected. Please disconnect this reader.
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2. Go to 'User Tools' -> 'Screen Features':

3. 'Screen Device Settings'
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4. 'IC Card / Bluetooth Software Settings'

5. 'Select IC Card Reader' 
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6. Select 'Proximity Card Reader':

7.  Click 'Proximity Card Reader Settings'.
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8.  Connect the Inepro Card Reader to the SOP, preferably on the internal USB Mini-B port on the
right side of the panel, behind the cover. The USB-A port on the left side could be used as an
alternative.

     

9. Wait for about 5 seconds for it to become visible.
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10.  The Inepro Card reader should now be available. Click on the reader.

11. Select 'Inepro Card Reader'





Appendix IIX: Set up Time
Registration

PartXV
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Appendix IIX: Set up Time Registration

 Set up Time Registration

§ Open the Inepro Back Office Manager
§ In the Inepro Back Office Manager go to the 'Advanced -> Card/Account Groups' and add or edit an

account group.

§ In the Card/Account group check the 'Time Registration Enabled' box.
§ Open the Business Server Config Tool.
§ In the Business Server Config Tool go to the config group of your MFP.
§ Insert the 'EnableTimeAndAttendanceClient' value and set it to TRUE.



Appendix IX: Set up Anonymous
Usage

PartXVI
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 Anonymous usage
Our systems are mostly used to register who does what on the MFP.
When it is not required that the end-users are known in the system, and / or it is not important to
know who does what in the system, Anonymous Login can make the DocuPRO Embedded for Ricoh
interface a little bit more faster. All transactions will still be registered and can still be required to pay
for, but you can start your action with a touch on the screen. To use Anonymous logon these
requirements must be fulfilled:

§ Business Server Setting: 'DeviceTag':   must be set to unique 'username' that will be used by
the MFP to log in.

§ Business Server Setting: 'HideUsernamePasswordEntry':   must be set to: 'TRUE'.

1.  Open the Inepro Business Server Config Tool and for the group of MFP's that need Anonymous
logon add the settings: 'DeviceTag' and 'HideUsernamePasswordEntry'.

2. Set 'DeviceTag' to a unique username.
3. Set 'HideUsernamePasswordEntry' to 'TRUE'.

31

32
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4. Add a user. This user will be registered as the user under which all the users at the MFP's in the
group will make transactions, so make sure the User Code is a recognisable name, for report
purposes.
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5. Create a new account. This account must be linked to user in step 4.

6. Create a new tag in that account. That tag must have the same 'ID Code' as the DeviceTag in step
2. The ID of the tag must be recognisable as the tag under which all the users at the MFP's in the
group will make transactions, for report purposes.
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7.  If everything has gone correctly, you should see this screen and must be able to make a
transaction that will be registered under the unique name you enter at step 2 at the 'DeviceTag'.





Appendix X: Edit settings via
Android panel
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Edit service configuration via Android panel

An alternative way to change the settings is to do it via the Android panel.
Browse on the Android panel to the Software Individual Settings:

Select “User Tools”
Choose Screen Features-->
 Screen Device Settings ->

IC Card/Bluetooth Software Settings -->
Software Individual Settings -->
Inepro Card Reader

Select 'DocuPRO Settings…' to enter the settings for DocuPRO. Currently only Business Server
address can be changed
See 'Terminology: Business Server on page:   

4

4



Notes
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Notes

 Notes

This area is meant for the reader's notes:
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